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Agenda

■ Combining protocols and ontology by JADE agents

■ Goal-directed agents build with use Jadex BDI 
reasoning engine
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Ontology and protocols
in JADE
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Utilizing in ontology

1. Creating JADE-compliant ontology
 Tools: 

 Protege
 Templates:

2. Converting ontology into Java beans
  Tools: 

  Jadex Ontology Beananizer
  Acklin's Ontology BeanGenerator

3. Creating knowledge-base
1.Tools:

1.JADE Semantic Add-On
4. Communicating and processing knowledge

1.Tools:
1.JADE
2.JADE Semantic Add-On
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public abstract class MemKB extends KB {
  protected Map facts = new HashMap();
  protected Object insert(Object name, Object fact) {
    ...
    return facts.put(name, fact);
  }
  protected abstract boolean match(Object template, 
    Object fact);
  public List search(Object template, int maxResults) {
    List result = new ArrayList();
    Iterator it = facts.values().iterator();
    int found = 0;
    while(it.hasNext() && 
       ((maxResults < 0) || (found < maxResults)) ) {
      Object fact = it.next();
      if(match(template, fact)){
        result.add(fact);
        found ++;

 }
    }
    return result;
  }
  ...
}

public class DFMemKB extends MemKB {
  public final boolean match(Object template, Object fact) {
    return compare(template, fact);
  }
  public static final boolean compare(Object template,  
      Object fact) {
    // Match name
    // Match protocol set
    // Match ontologies set
    // Match languages set
    // Match services set
    return ...;
  }
  ...
}
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Subscription

■ Protocol documentation
■ JADE implementation support
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FIPA Subscribe Protocol
● Allows the Initiator to 

send a subscribe message 
to the Participant 
indicating its desired 
subscription. 

● The Participant: 
● responds to the query 

request by either 
accepting (agree) or 
rejecting (refuse) the 
subscription

● communicates all 
content matching the 
subscriptions condition 
using an an inform 
communicative act with 
a result predicate as 
content 
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FIPA Cancel Meta Protocol
● The Participant 

continues to send 
inform-results until 
either 
● the Initiator 

cancels, 
communicated by 
sending a cancel 
message, 

● or the Participant 
experiences a 
failure, 
communicated 
with a failure 
message.
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Subscription Initiator behaviour

■ The implementation of the interaction provides a set of callback 
methods to handle each state of the protocol
 these are called when a certain type of message (based on its 

communicative act) is received.
➔protected handleAgree(ACLMessage agree)
➔protected handleRefuse(ACLMessage refuse)
➔protected handleInform(ACLMessage inform)

■ Method for canceling the subscription:
 public cancel(AID receiver, boolean 
ignoreResponse)

 Cancel the subscription to agent receiver. This method retrieves 
the subscription message sent to receiver and sends a suitable 
cancel message. 

 The content slot of this cancel message is filled in by means of 
the fillCancelContent() method.
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Subscription Responder behaviour

■ Implements the FIPA-Subscribe 
interaction protocol from the point 
of view of a responder to 
subscription message.

■ It is very important to pass the right 
message template to its constructor 
as it is used to select the 
ACLMessage to be served.

■ Examples
 Directory Facilitator Agent 

(jade.domain.df.java)
 JMSPubSub Agent add-on 

utility
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Subscription Manager

■ When a new subscription message 
arrives, the 
SubscriptionResponder 
invokes the register() method 
of its SubscriptionManager.

■ When a cancel message is received 
the deregister() method is 
called. 

■ The applications 
SubscriptionManager is 
expected to implement the 
register() and 
deregister() methods.
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Subscription

■ When a notification has to be sent 
to a subscribed agent the 
notification message should not be 
directly sent to the subscribed 
agent, but should be passed to the 
Subscription object 
representing the subscription of 
that agent by means of its 
notify() method. 

■ This method should be call instead 
of directly using the send() 
method of the Agent class, as it 
automatically handles sequencing 
and protocol fields appropriately.
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Example: DF Agent
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Communicative Act Categotegories
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Protocol Notation
■ Rectangle with double edges – communication act 
■ White rectlange – action performed by initiator
■ Gray rectangle – action performed by others participants of a protocol
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Subscribe Protocol Syntax
Requesting general information fulfilling given predicate

Requesting result of given action

(iota x (P x))
    the x such that P [is true] of x

(= x y)
    binary predicate of equality 

?x
    notion of variable

action 
= “action” actor   
    action-name
actor
    AID of agent requested to act

result action y
     y is result computational action a
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Example: Subscribing at DF
((iota ?x (result (action ( df ) 
  (search (df-agent-description 
    :name ( agent-identifier :name ta@beethoven:1099/JADE  
    :addresses (sequence http://beethoven:7778/acc ) 
    :X-JADE-agent-classname MyAgent ) 
    :services (set (service-description 
      :name JADE-book-trading 
      :type book-selling))) 
  (search-constraints :max-results -1))) ?x)))

((= (iota ?x (result (action ( df ) 
  (search (df-agent-description 
    :name ( agent-identifier :name ta@beethoven:1099/JADE  
    :addresses (sequence http://beethoven:7778/acc ) 
    :X-JADE-agent-classname MyAgent ) 
    :services (set (service-description 
      :name JADE-book-trading 
      :type book-selling))) 
    (search-constraints :max-results -1))) ?x))) 
  (sequence (df-agent-description 
    :name (agent-identifier 
      :name ta@beethoven:1099/JADE
      :addresses (sequence http://beethoven:7778/acc)) 
    :services (set (service-description 
      :name JADE-book-trading 
      :type book-selling))))))

subscribe 
content

inform
content

result of 
search action
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DF Agent Description frame

FIPA Agent Management Specification, http://www.fipa.org/specs/fipa00023/index.html
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Service Description frame

FIPA Agent Management Specification, http://www.fipa.org/specs/fipa00023/index.html
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Subscribe Communicative Act

■ Summary:
The act of requesting a persistent intention to notify the sender of 
the value of a reference, and to notify again whenever the object 
identified by the reference changes.

■ Message content: 
A definite descriptor

■ Description:
[...]
A subscription set up by a subscribe act is terminated by a cancel 
act.
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Subscriptions condition

■ Example
Agent i wishes to be updated on the exchange rate of Francs to 
Dollars, and makes a subscription agreement with j (an exchange 
rate server)

(subscribe
    :sender i
    :receiver j
    :content (iota ?x (xch-rate FFr USD ?x))
)
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■ General
 T. R. Gruber. A translation approach to portable ontologies. Knowledge Acquisition, 5(2):199-

220, 1993. http://www-ksl.stanford.edu/kst/what-is-an-ontology.html

■ N. F. Noy, D. L. McGuinness (2001), Tutorial: Ontology Development 101  
http://protege.stanford.edu/publications/ontology_development/ontology101.html 

■

http://www-ksl.stanford.edu/kst/what-is-an-ontology.html
http://protege.stanford.edu/publications/ontology_development/ontology101.html
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Why create an ontology?

■ An ontology provides a common vocabulary for 
researchers who need to share information in the 
domain. Some of the reasons to create an ontology are:

 To share common understanding of the structure of 
information among people or software agents

 To enable reuse of domain knowledge
 To make domain assumptions explicit
 To separate domain knowledge from operational knowledge
 To analyze domain knowledge


■
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Ontology in Protégé

■ Ontology:
“Specification of conceptualization”*

 i.e. specification of 
➔ what exists 
➔ what are relations among parts

■ In context of Protégé**:
 Description of:

➔ classes (concepts) in a domain of discourse
➔ slots (properties) of each class describing various features and 

attributes of the class
 An ontology together with a set of individual instances of 

classes constitutes a knowledge base.

* T. R. Gruber. A translation approach to portable ontologies. Knowledge Acquisition, 5(2):199-220, 1993.

** N. F. Noy, D. L. McGuinness (2001), Tutorial: Ontology Development 101 
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Protégé-Frames

■ Getting Started with Protégé-Frames
http://protege.stanford.edu/doc/tutorial/get_started/get-started.pdf 

http://protege.stanford.edu/doc/tutorial/get_started/get-started.pdf
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Importing JADE base ontology

■ Open Project->Manage Included Projects... menu item
■ Click Add Project button (with + icon)
■ Choose beanynizer_default.pprj project and click OK.
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Creating own ontology

■ Choose Create New Project button or open File->New Project... 
menu item.

■ Select a project type: Protégé Files (.pont and .pins) and click OK.

■ Save project (enter only desired project path name) and click OK.
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Switching Jadex Beanynizer plugin 

■ Open Project->Configure... menu item.

■ Turn on Beaninizer option in Widgets tab and click OK.

■ Switch into Jadex Beanynizer tab.
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Bean base ontology in Protégé
Base ontology is defined in 
    beanynizer_default.pprj
Protégé project file from Jader Beanynizer plugin.

The Classes Tab is an ontology editor which you can use to define 
classes and class hierarchy, slots and slot-value restrictions, 
relationships between classes and properties of these relationships.
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JADE Content Reference Model
Base ontology is realized by the following concepts in JADE:
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Handling content expressions
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Semantic Add-on vs. Jadex

■ Semantic Add-on
 allows for communications on a semantic level, 

which means that the agent can understand each 
other

 +JADE =  a step towards a real communication-
oriented middleware

■ Jadex
 addresses the internal reasoning process of agents 
 an implementation of a hybrid (reactive and 

deliberative) agent architecture for representing 
mental states in JADE agents following the BDI 
model.
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Jadex as realization 
of BDI Architecture
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BDI

■ Deciding on what goals to achieve and 
how to achieve them

 Beliefs: the information an agent has about 
its surroundings

 Desires: the things that an agent would like 
to see achieved 

 Intentions: the desires that an agent is 
working on; also involves a deeper personal 
commitment

■ A BDI architecture addresses how 
beliefs, desires and intentions are 
represented, updated, and processed
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Jadex, BDI extension to JADE

■ Jadex open source project
http://vsis-www.informatik.uni-hamburg.de/projects/jadex/ 

■ Background: two different type agent platform exists:
 FIPA-compliant platforms mainly addressing openness and 

middleware issues (with to respect FIPA standards)
 Reasoning-centered platforms focusing on the behaviour 

model of a single agent, e.g. trying to achieve rationality and 
goal-directedness. 

■ Jadex fill the gap between middleware and reasoning-centered 
systems.

http://vsis-www.informatik.uni-hamburg.de/projects/jadex/
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Launching sample
■ Unpack the distribution

■ Set the classpath:
 Java: .;C:\Java\jdk1.5.0_04\lib; 
 JADE: C:\jade\lib\jade.jar; C:\jade\lib\jadeTools.jar; 
C:\jade\lib\Base64.jar; C:\jade\lib\http.jar; 
C:\jade\lib\iiop.jar;

 Jadex: C:\jadex-0.94\lib\jadex_rt.jar; C:\jadex-
0.94\lib\jibx-run.jar; C:\jadex-0.94\lib\xpp3.jar; 
C:\jadex-0.94\lib\jadex_standalone.jar; C:\jadex-
0.94\lib\jadex_tools.jar; C:\jadex-
0.94\lib\GraphLayout.jar; C:\jadex-0.94\lib\jhall.jar; 
C:\jadex-0.94\lib\jadex_examples.jar

■ Start the platform: 
   java jadex.adapter.standalone.Platform

■ The Jadex Control Center will appear
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The cleanerworld is based on the idea that an 
autonomous cleaning robot has the task to clean up dirt 
in some environment. 

In our scenario of the cleaner world the main system 
objectives are to keep clean a building at day, e.g. a 
museum, and to guard the building at night. 

To be more concise we think of a group of cleaning 
robots that are located in the building and try to 
accomplish the overall system goals by pursuing their 
own goals in coordination with other individuals. 

Example: World Cleaner Scenario
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Key goals of World Cleaner
● Therefore, three key goals for an individual cleaning robot were 

identified. 

● First, it should clean its environment at day by removing dirt 
whenever possible. The cleaning robot therefore has to pick-up 
any garbage and carry it to a near waste bin. 

● Secondly, it has to guard the building at night by performing 
patrols that should be based on varying routes. Any suspicious 
occurrences that it recognises during its patrols should be 
reported to some superordinated authority. 

● Thirdly, it should keep operational by monitoring its internal 
states such as the charge state of its battery or recognised 
malfunctions. Whenever its battery state is low it has to move to 
the charging station. 
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Cleaner: Top Level Goals & Plans
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CleanerWorld Ontology
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Jadex Agent

■ A Jadex agent has two basic parts:
 An Agent Definition File (ADF) written in XML
 A set of Java classes, which specialize Jadex built-in classes, 

to specify how plans (intentions) are constructed out of 
beliefs and goals (desires)
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Agent Definition File
 XML file describing agent in respect to 

Jadex XML
http://jadex.sourceforge.net/jadex-0.94.xsd 

 Schema described in Jadex documentation

 Tool for editting: XMLBuddy plugin for 
Eclipse
http://www.xmlbuddy.com/  

http://jadex.sourceforge.net/jadex-0.94.xsd
http://www.xmlbuddy.com/
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Beliefs in the ADF

<beliefs>
  <belief name="environment" class="IEnvironment">
    <!-- local environment (comment out for remote) -->
    <!--<fact>Environment.getInstance()</fact>-->
  </belief>
  ...
  <!-- The points used for patrolling at night. -->
  <beliefset name="patrolpoints" class="Location">
    <fact>new Location(0.1, 0.1)</fact>
    <fact>new Location(0.1, 0.9)</fact>
    <fact>new Location(0.3, 0.9)</fact>
    <fact>new Location(0.3, 0.1)</fact>
    <fact>new Location(0.5, 0.1)</fact>
    <fact>new Location(0.5, 0.9)</fact>
    <fact>new Location(0.7, 0.9)</fact>
    <fact>new Location(0.7, 0.1)</fact>
    <fact>new Location(0.9, 0.1)</fact>
    <fact>new Location(0.9, 0.9)</fact>
  </beliefset>
</beliefs>

■ Belief
A single-valued piece of agent knowlegde.

■ BeliefSet
A multi-valued piece of agent knowlegde.

■ fact
An expression that evaluated to a default value.
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Access to beliefs within Plan body

/**
 *  Patrol along the patrol points.
 */
public class PatrolPlan extends Plan {
  //-------- constructors --------
  /**
   *  Create a new plan.
   */
  public PatrolPlan() {
   getLogger().info("Created: "+this);
  }
  //-------- methods --------
  /**
   *  The plan body.
   */
  public void body() {
    Location[] loci = 
     (Location[])getBeliefbase().getBeliefSet("patrolpoints").getFacts();
    
    for(int i=0; i<loci.length; i++) {
      IGoal moveto = createGoal("achievemoveto");
      moveto.getParameter("location").setValue(loci[i]);

 dispatchSubgoalAndWait(moveto);
    }
  }
}
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Object Query Language-like queries

<!-- Try to find a not full waste bin that
is as near as possible to the agent. -->

<querygoal name="querywastebin" exclude="never">
  <parameter name="result" class="Wastebin" direction="out">
    <value evaluationmode="dynamic">

  select one Wastebin $wastebin
  from $beliefbase.wastebins
  where !$wastebin.isFull()

       order by       
         $beliefbase.my_location.getDistance($wastebin.getLocation())
    </value>
  </parameter>
</querygoal>

select expression ::= ”SELECT”(”ALL” | ”ANY” | ”IOTA”)?
(
  (expression ”FROM”(”$” identifier ”IN” expression) (”,””$” identifier ”IN” expression)* )
 | (”$” identifier ”FROM”expression)
 )
 (”WHERE” expression)?
 (”ORDER””BY”expression (”ASC” | ”DESC”)? )?

OQL syntax in EBNF:

Query example inside of Query Goal:
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Goal lifecycle
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Situation of conflicting goals

■ Goal-oriented agent is capable of purisying multiple goals 
simultaneously

■ Some goals could be conflicted
 Example:

➔ Agent cannot both Maintain Battery Loaded and Perform 
Look For Waster, or Perform Patrol

➔ Agent cannot look for a new waste, if the old one has not 
been cleaned up

■ Some goals require limitation in number of activated instances:
 Example

➔ For improved performance, the cleaner should alsway clean 
up the nearest piece of waste first
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Goals deliberation strategy (1)

■ Goals deliberation allows for avoiding activatation of conflicted 
goals

■ Jadex uses Easy Deliberation strategy for this purpose

■ Driving factors:
 Cardinalities for goal instances

Only x instances of a certain type of goal is allowed to be active 
simultanously

➔ Example:
- Achieve Cleanup Waste goal with cardininality of 1

 Inhibition links:
Goals which has been activated should suspend goals inhibited 
by it

➔ Example:
- If an agent Maintains Battery Loaded then it inbits 

realization of all other goals
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Goals deliberation strategy (2)

■ Graph consitisting of inhibiting arc should be acyclic to avoid cycles 
in deliberations

<!-- Observe the battery state. -->
<maintaingoal name="maintainbatteryloaded">
  <deliberation>
    <inhibits ref="performlookforwaste" inhibit="when_in_process"/>
    <inhibits ref="achievecleanup" inhibit="when_in_process"/>
    <inhibits ref="performpatrol" inhibit="when_in_process"/>
  </deliberation>
  <!-- Engage in actions when the state is below 0.2. -->
  <maintaincondition>
    $beliefbase.my_chargestate > 0.2
  </maintaincondition>
  <!-- The goal is satisfied when the charge state is 1.0. -->
  <targetcondition>
    $beliefbase.my_chargestate >= 1.0
   </targetcondition>
</maintaingoal>
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When often should be delibarate ?

■ Only on demand

 1: Deliberate a new option
Check which inhibited goals should be suspended

 2: Deliberate a deactive goals
Check which inhibited goals should be reactivated.
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Goal types in Jadex

■ Perform
■ Achieve
■ Query
■ Maintain
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Goal elements: conditions
■ CreationCondition

A condition that creates a new goal of the given type when triggered.
■ DropCondition

If the dropcondition triggers the goal instance is dropped.
■ Deliberation

The goal deliberation setting for the easy deliberation strategy.
■ ContextCondition

The context condition is checked during the whole execution time of a 
goal. If it becomes invalid the goal will become suspended and is not 
actively pursued until reactivation.

■ MaintainCondition
The mandatory maintain condition represents a world state that should be 
monitored and re-established whenever it gets violated.

■ TargetCondition
A specalisation of the maintain condition taht should be re-established 
when the maintain condition is violated.

■ FailureCondition
Can be used to explicitly state when a goal cannot be pursued any longer 
and is failed.
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Maintain goal states

<!-- Observe the battery state. -->
<maintaingoal name="maintainbatteryloaded">
  <deliberation>
    <inhibits ref="performlookforwaste" inhibit="when_in_process"/>
    <inhibits ref="achievecleanup" inhibit="when_in_process"/>
    <inhibits ref="performpatrol" inhibit="when_in_process"/>
  </deliberation>
  <!-- Engage in actions when the state is below 0.2. -->
  <maintaincondition>
    $beliefbase.my_chargestate > 0.2
  </maintaincondition>
  <!-- The goal is satisfied when the charge state is 1.0. -->
  <targetcondition>
    $beliefbase.my_chargestate >= 1.0
   </targetcondition>
</maintaingoal>
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Perform goal

<!-- Look out for waste when nothing better to do, what means that
the agent is not cleaning, not loading and it is daytime. -->

<performgoal name="performlookforwaste" retry="true" exclude="never">
  <contextcondition>
    $beliefbase.daytime
  </contextcondition>
</performgoal>
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Query goal

<!-- Try to find a not full waste bin that
is as near as possible to the agent. -->

<querygoal name="querywastebin" exclude="never">
  <parameter name="result" class="Wastebin" direction="out">
    <value evaluationmode="dynamic">
      select one Wastebin $wastebin

 from $beliefbase.wastebins
 where !$wastebin.isFull()
 order by  

        $beliefbase.my_location.getDistance($wastebin.getLocation())
    </value>
  </parameter>
</querygoal>



58

Achieve goal

<!-- Drop a piece of waste into a wastebin. -->
<achievegoal name="achievedropwaste" retry="true" exclude="never">
  <parameter name="wastebin" class="Wastebin"/>
  <!-- The goal has failed when the aimed wastebin is full. -->
  <failurecondition>
    (select one Wastebin $wastebin
    from $beliefbase.wastebins
    where $goal.wastebin.getId().equals($wastebin.getId())).isFull()
  </failurecondition>
</achievegoal> <!-- Try to move to the specified location. -->

<achievegoal name="achievemoveto">
  <parameter name="location" class="Location"/>
  <!-- The goal has been reached when the agent's location is
       near the target position as specified in the parameter. -->
  <targetcondition>
    $beliefbase.my_location.isNear($goal.location)
  </targetcondition>
</achievegoal>
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Jadex: 
Getting
Started
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Goal structure in ADF


